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Introduction 

This Job Aid is intended for CONNECTIONS users on different levels. It provides a detailed 
overview of the CONNECTIONS system changes and enhancements introduced in Q3-08 
(Build 18.10).  

Improvements to CONNECTIONS that are implemented periodically through SIRs and Change 
Requests are referred to as "builds." Since these improvements are implemented on a quarterly 
basis, they are also being called Quarterly Improvement Plans and are referred to this year as 
Q1-08, Q2-08, Q3-08 and Q4-08. The Q1, 2, 3, or 4 indicates the quarter of the year beginning 
in January and "08" represents 2008. Build 18.10, to be released in October 2008, is called "Q3-
08."  

With the implementation of Q3-08 (Build 18.10), several important changes will improve the 
CONNECTIONS system. It should be noted that many of the enhancements included in this 
build originated from a collaborative effort on the part of OCFS, local district and voluntary 
agency casework and supervisory staff. Specifically, this Job Aid contains information about 
enhancements in the following functional areas: 

• Safety Assessment 

• Risk Assessment Profile (RAP) 

• To-Do  

• Progress Notes 

• Foster and Adoptive Home Development (FAD) 

Also included in Q3-08 is support for Child Protective Services Family Assessment Response 
(FAR). Family Assessment Response is a new services approach for working with some 
families reported to the New York State Child Abuse and Maltreatment Register (SCR) for 
suspected maltreatment of their children. With implementation of Q3-08, six local districts will be 
participating in FAR. They are: Chautauqua, Erie, Onondaga, Orange, Tompkins and 
Westchester. Additional information for non-participating districts and agencies regarding FAR 
will be contained in an informational letter that will be issued prior to any of the six counties 
initiating FAR. The districts participating in FAR will be issued a Job Aid specifically for their use. 

 

Any visible identifying data 
in this Job Aid is simulated. 

 

 

This Job Aid assumes familiarity with the 
CONNECTIONS System. 

 
This Job Aid is available online on the CONNECTIONS intranet site: 

http://ocfs.state.nyenet/connect/jobaides.asp 

The CONNECTIONS Intranet site also contains information about CONNECTIONS training. 
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Redesigned Safety Assessment 

Across the country and internationally, child welfare experts are continually looking to refine 
their safety and risk assessment protocols so that they are easier to use and provide reliable, 
consistent and valid assessment information. Based on this as well as input from users, OCFS 
determined that the Safety Assessment needed to have more clearly defined terms and to more 
explicitly emphasize if any action was needed to protect children, what that action was, and who 
was responsible for it. In that way, it would better assist critical thinking and decision-making. 
Therefore, with the implementation of Q3-08 (Build 18.10) changes will be made to the Safety 
Assessment window for INV and FSS stages. 

A new version of the CPS Safety Assessment is being implemented with Q3-08 (Build 18.10).  
All Investigation stages with a post-implementation start date will contain the new version of the 
Safety Assessment, while all Investigation stages opened prior to implementation will continue 
to support the old version.  For Family Services Stages, all FASPs launched post-
implementation will contain the new version. In-Process FASPs will support the new version if 
no data had been saved on the Safety Assessment window prior to implementation.  FASPs 
with a status of pending, approved, or rejected as of the implementation date will continue to 
support the old version of the Safety Assessment.  

Safety Assessment Window Changes 

Although several important improvements have been made, much of the current Safety 
Assessment window remains unchanged. For example, the four tab format remains the same 
and navigation to and within the window is unchanged. What you will notice is that the Safety 
Decision tab has been moved to second position and that the Mitigating 
Strengths/Resources tab is no longer part of the Safety Assessment window. In its place you 
will see a new tab entitled Prnt/Crtkr Actions/Safety Plan (Parent(s)/Caretaker(s) 
Actions/Safety Plan). The Safety Interventions tab has been renamed to the Ctrl 
Interventions/Safety Plan (Controlling Interventions/Safety Plan).   

The names of the four tabs and their purpose are as follows: 
 

Safety Factors – This tab is used to identify any existing safety factors, determine whether any rise to the 
level of immediate or impending danger, as well as record comments related to each safety factor you 
identified. 

Safety Decision – This tab is used to record your conclusion as to the safety status of the child(ren). 

Prnt/Crtkr Actions/Safety Plan – This tab is used to record a narrative related to the specific action(s) 
taken or to be taken by the parent(s) or caretaker(s) to protect the child(ren) from the identified danger(s). 

Ctrl Interventions/Safety Plan – This tab is used to identify interventions that have been implemented to 
control for the safety of the child(ren) and to record a narrative explaining how the safety plan will be 
monitored. 
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An additional change to the Safety Assessment window concerns the pre-filling of a safety 
assessment from one previously completed and approved.  With the implementation of Q3-08 
(Build 18.10), a new safety assessment in an Investigation stage will be pre-filled from the most 
recent approved safety assessment in an open Investigation stage within the same case, if the 
previous safety assessment has an approval date of 60 days or less from the date of accessing 
the new safety assessment.  Investigation safety assessments will pre-fill into the FSS/FASP as 
they do now. In both situations, there will be no pre-fills from a pre-Build safety assessment into 
a post-Build safety assessment (i.e., a pre-build INV will not pre-fill into a post-build FSS). . 

Changes to Safety Definitions 

The definitions of safety terms that can be found in Appendix A have been revised to be made 
simpler and less open to various interpretations. You will now notice the addition of “Impending 
Danger" to the safety definitions, and on various tabs of the Safety Assessment. 
 
Impending Danger is defined as: A child is in impending 
danger when exposure to serious harm is emerging, about to 
happen, or is a reasonably foreseeable consequence of 
current circumstances.   
 
The definition was changed to help you focus beyond 
“immediacy.”  Safety is about the exposure of children to 
danger to serious harm - both right now and in the immediate 
future. Just because the danger isn’t occurring right in front of 
you does not mean that it doesn’t exist and that the child’s 
safety is not threatened. The behaviors and conditions that 
create danger to children are fluid- they change - and you and 
your supervisor must be able to detect if danger of serious 
harm might emerge in the very near future.   

 

 

What’s 
New Safety Factors Tab in the Safety Assessment Window INV and FSS Stages 

 

 

 

 

 

Addition of 
Impending 
Danger  

  
You will also notice a new 
button at the bottom of the 

Safety Assessment 
window in the INV and 
FSS stages called the 

Light Bulb button. 

 
To bring up a list of safety 
definitions, click on the 
Light Bulb button. 
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Safety Factors Tab 

The Investigation safety assessment in the Investigation stage will no longer have any pre-filled 
safety factors identified by the SCR in the CPS Intake stage. The CPS 
worker may view the safety factors identified by the SCR intake 
worker by navigating to the Intake Stage. This change was made to 
permit CPS investigators to make a fresh assessment of safety at the 
beginning of the CPS case.   

As is presently the case, if you select the “No Safety Factors are 
present at this time” checkbox, all other safety factors in the list, along 
with the comment box and Immediate or Impending Danger 
Factors grid, become disabled. But if you identify one or more of the 
safety factor(s) from the Safety Factors grid, you must now record a separate comment for 
each factor selected. When a safety factor is checked, the comment box will turn yellow, 
indicating that it is a required field. If you attempt to navigate to another tab without first 
recording all required comments, the following message displays: “You must comment on the 
selected safety factors.” This does not prevent you from navigating to another tab, however, you 
will not be able to submit the Investigation Safety Assessment for approval or mark the Safety 
Assessment associated to a periodic FASP ready for FASP submission until you have recorded 
comments for each selected safety factor.  

The comments should describe the behaviors or circumstances that you found that are the 
basis for identifying the safety factor. 

As is presently the case, the Immediate or Impending Danger Factors grid at the bottom of 
the Safety Assessment tab will be dynamically populated with each safety factor you have 
selected.  As you do now, identify, by checking, any of the safety factors that you judge place 
the child(ren) in immediate or impending danger of serious harm.   

Safety Decision Tab 
 
The safety decision is a statement of the current safety status of the child(ren) and the actions 
that are needed to protect the child(ren) from immediate or impending danger of serious harm.  
A safety decision is dynamic, and is always based on the information you have available to you 
at the time of the decision. 

Although the Safety Decision tab is always enabled you must 
select at least one safety factor on the Safety Factors tab before 
you can select a safety decision. On this tab you select one and 
only one safety decision from the list. If you select "No Safety 
Factors are present at this time" ion the Safety Factors tab, then 
the Safety Decision #1 "No Safety Factors were identified at this 
time…" is automatically pre-populated and the rest of the decision 
choices are disabled. Based upon the safety decision you choose, 
the Prnt/Crtkr Actions/Safety Plan tab and the Ctrl 
Interventions/Safety Plan tab remain disabled, become enabled 
and optional, or become enabled and required. If you select Safety Decision #4, the Placement 
sub-window opens where you identify the children who have been placed and, if necessary; 
address the safety of any children who remain in the home.    

 
See Appendix C for a 

chart that details safety 
decision selections and 

their corresponding 
results in grid form. 

  
See Appendix B for 
the detailed wording 
changes to Safety 

Factors. 
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Examples of enabled and disabled tabs by selection of safety decisions in the Safety 
Assessment window are shown below: 

 

 

 

 

What’s New Safety Decision Tab in the Safety Assessment Window INV and FSS Stages
 
 
 
 
Selecting Safety 
Decision #1: 
 
Prnt/Crtkr 
Actions/Safety 
Plan and Ctrl 
Interventions/ 
Safety Plan tabs 
are disabled. 
 
 

 

What’s New Safety Decision Tab in the Safety Assessment Window  
INV and FSS Stages 

 
 
Selecting Safety 
Decision #2: 
 
Prnt/Crtkr 
Actions/Safety 
Plan tab is 
enabled and 
optional.  
 
Ctrl 
Interventions/S
afety Plan tab is 
disabled. 
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What’s New Safety Decision Tab in the Safety Assessment Window INV and FSS Stages
 

 

Selecting Safety 
Decision #3:  

 

Prnt/Crtkr 
Actions/Safety Plan 
and Ctrl 
Interventions/Safety 
Plan tabs are enabled 
and required. 

 

 

What’s New Safety Decision Tab in the Safety Assessment Window INV and FSS Stages
 

 

Selecting Safety 
Decision #4:  
 
Prnt/Crtkr 
Actions/Safety Plan 
tab is enabled and 
optional. 
 
Ctrl 
Interventions/Safety 
Plan tab is enabled 
and required. 
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Safety Plan 

The Safety Plan that is being introduced in Q3-08 (Build 18.10) consists of: 

• the actions that taken or that will be taken by the parent(s)/caretaker(s) to protect the 
child(ren) that you will record as narrative in the Prnt/Crtkr Actions/Safety Plan tab; 

• the controlling intervention(s) you have put in place that you will record by selecting from 
the checklist, on the Ctrl Interventions/Safety Plan tab; and 

• any protective actions associated with Safety Decision #4 (Placement) sub-window.  

A Safety Plan is different from a Service Plan in that the Safety Plan defines a set of actions to 
be taken without delay to protect the child(ren) from immediate or impending danger of serious 
harm whereas the Service Plan describes the risk reduction and family related outcomes and 
activities that will support reunification or another permanency plan and/or the resolution of 
family problems. 

What’s New Safety Decision Tab in the Safety Assessment Window INV and FSS Stages
 

Selecting Safety 
Decision #5: 

Prnt/Crtkr 
Actions/Safety Plan 
tab is disabled. 
 
Ctrl 
Interventions/Safety 
Plan tab is enabled 
and required. 
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Prnt/Crtkr Actions Safety Plan Tab 
 
As you have seen, the Prnt/Crtkr Actions/Safety Plan tab is enabled (required or optional) or 
disabled depending upon the decision you select on the Safety Decision tab. Here you record 
a narrative related to the specific actions taken or to be taken by the parent(s)/caretaker(s) to 
protect the child(ren), fully or partially, from the identified danger(s).  You also describe the 
parent(s)/caretaker(s)’ ability to keep the protection(s) in place, for how long, and/or under what 
circumstances the parent(s)/caretaker(s) must maintain these specific protective action(s).   
Note that the tab is supported by several text tools, including spell check and copy/paste 
commands. 
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Ctrl Interventions/Safety Plan Tab 

 As noted above, controlling interventions make up the second part of the safety plan, in 
accordance with the chosen safety decision.  The changes on this tab are: 

• The tab is now named Controlling Interventions/Safety Plan;  

• The instruction at the top of the list of Interventions prompts you to check all of the 
interventions that you have implemented to control for the 
safety of the child(ren);  

• The list of interventions has been modified/expanded;   

• When completing the narrative, you are prompted to 
describe how each intervention that you identified is 
protecting the child(ren) from the identified danger, who is 
responsible for taking and/or maintaining the specific 
interventions and how the implementation of the safety plan 
will be monitored; and 

• If you select Controlling Intervention # 19 (Use of Family, Neighbors . . .) or # 23 (Other), 
the comment box will turn yellow indicating that it is a required field.   If # 19 is selected, 
specify which individuals will serve as safety resources, what they will do, for what 
period of time, etc.  For # 23, provide the appropriate details.   

For INV stages you will not be able to mark the Safety Assessment complete (and submit to 
your supervisor) if the tab is required but incomplete. For FSS stages you will not be able to 
mark the Safety Assessment as “Ready for FASP Submission” if the tab is required but 
incomplete.  

 

 
See Appendix D for a 

list of Controlling 
Intervention 
selections. 



 

CONNECTIONS Q3-08 (Build 18.10) (9/24/2008)                                                  10

Safety Plan Output 
With Q3-08 (Build 18.10), CONNECTIONS will populate a new Safety Plan output with the 
information you recorded on the Prnt/Crtkr Actions/Safety Plan tab, the Ctrl 
Interventions/Safety Plan tab and if applicable, the narrative from the Placement sub-window 
associated with Safety Decision #4. Demographic information also pre-fills the plan with slight 
differences depending on whether the plan is being produced 
from an INV or FSS stage. This plan can be printed, reviewed 
with the parents and offered for their signature, along with your 
signature and others who may be appropriate to sign the plan, 
such a grandmother if she has a role in the Safety Plan. 

The new Safety Plan output will be available only if the stage 
was opened on or after the date of Q3-08 (Build 18.10) 
implementation.  

You may update a safety plans at any time during the INV 
stage to reflect changing circumstances. Once an FSS is 
opened with a Program Choice of “Protective,” you update the 
plan as part of the FASP cycle. 

The steps for generating a safety plan from the CRPS and FSS/FASP follow: 

 

Step-by-Step: 
Printing a Safety Plan From the CPRS 

 
1. In the Safety Assessment tab of the Child Protective Record Summary window, click to 

select a safety assessment for which you wish to generate a safety plan. 
 

2. Click on the Detail button.  
The safety assessment will display. 

 
3. In the File menu, select Print Safety Plan.  

The safety plan displays. 
 

4. To print the safety plan, click on the Print button. The Print dialog box displays. Verify 
that the prompted printer choice is correct and select the number of copies to be printed.  

 
5. Click on the Print button.  

The document is sent to the selected printer. 
 

6. To close the safety plan, click on the Close button.  
The Safety Assessment window displays. 

 
7. Click on the Cancel button.  

The Child Protective Record Summary displays. 

 
See Appendix E for 

samples of Safety Plan 
output. Note the 
statement to the 

parent(s)/caretaker(s) on 
page 2 of the Safety Plan. 
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Printing a Safety Plan from the FASP 

The Safety Plan defines a set of actions to be taken without delay to protect the child(ren) from 
immediate or impending danger of serious harm.  

The Safety Plan consists of: 

• the actions that will be taken by the parent(s)/caretaker(s) to protect the child(ren) that 
you will record as narrative in the Prnt/Crtkr Actions/Safety Plan tab; 

• the controlling intervention(s) you have put in place that you will select from the 
checklist, and the associated narrative recorded on the Ctrl Interventions/Safety Plan 
tab; and any protective actions associated with Safety Decision #4 sub-window. 

 

Step-by-Step: 
Printing a Safety Plan From the FASP: For a Pending or In-Process FASP 

 
For a Pending or In-Process FASP: 

1. Via the Family Assessment and Service Plan (FASP) window, click on the Reports drop 
down menu item (located at the top of the window) select/highlight Family Assessment.  
The Family Assessment sub menu will display to the right.  

 
2. Click to select Safety Plan.  

The safety plan is displayed. 
 

3. To print the safety plan, click on the Print button.  
The Print dialog box displays. Verify that the prompted printer choice is correct and 
select the number of copies to be printed.  
 

4. Click on the Print button.  
The document is sent to the selected printer. A Generate Report window is displayed 
indicating the report has been queued to the printer.   

 
5. Click on the OK push button, to close the Generate Report window.  Focus is return to 

the Safety Plan.   
 

6. To close the safety plan, click on the Close button.  
Focus is returned to the Family Assessment and Service Plan window  

 
7. Click on the Close button.  

Focus is returned to the Family Assessment and Service Plan (FASP) window.  . 
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Step-by-Step: 
Printing a Safety Plan From the FASP: For an Approved FASP 

 

For an Approved FASP: 

1. Via the Family Assessment and Service Plan (FASP) window, double click on the 
‘Approved’ node.  The FASP report is displayed on the window.   

2. Click on the Print Selected button.   

3. The FASP Report component window is displayed.  Click and select Safety Plan.   A 
check mark is displayed once selected.   

4. Click on the OK push button.   
The Safety Plan report is displayed. 

 
5. To print the safety plan, click on the Print button. The Print dialog box displays. Verify 

that the prompted printer choice is correct and select the number of copies to be printed.  

6. Click on the Print button.  
The document is sent to the selected printer. 

 
7. Click on the Print button.  

The document is sent to the selected printer 
 
8. To close the safety plan, click on the Close button.  

Focus is returned to the Family Assessment and Service Plan window. 
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The Safety Plan can also be produced from the Event List, for an Approved FASP 

 

Step-by-Step: 
Printing a Safety Plan From the FASP: From the Event List for an 
Approved FASP 

 

1. Via the Assigned Work load window, Click on the Options drop down menu item.   

2. Click on Event List. 

3. Select the FASP submitted for Approval event and click on the Detail button. 
The FASP report is displayed on the window.   
 

4. Click on the Print Selected button.   
The FASP Report component window is displayed.   
 

5. Click and select Safety Plan.    
A check mark is displayed once selected. 

 
6. Click on the OK button.   

The Safety Plan report is displayed 
 
7. To print the safety plan, click on the Print button.  

The Print dialog box displays. Verify that the prompted printer choice is correct and 
select the number of copies to be printed.  
 

8. Click on the Print button.  
The document is sent to the selected printer. 
 

9. To close the safety plan, click on the Close button.  
Focus is returned to the ‘Event List’ window. 
 

10. Clicking on the Close button will return focus back to the ‘Assigned Work load’ window.   

Please Note: 

If the CPS Safety Assessment was NOT part of the FASP, the check box will be disabled.   

The Safety Assessment must be completed before the Safety Plan output can be generated.  
You may generate the plan from the CPRS tab dialog by clicking on the Options menu and 
selecting the Print Safety Plan command, which will only be enabled when you have 
highlighted an existing Safety Assessment in PROC, PEND, APRV, COMP or REJT status. The 
Safety Plan is also available from the Safety Assessment window. After navigating to the Safety 
Assessment Detail window, the Safety Plan can be generated by clicking on the File menu and 
selecting the Print Safety Plan command. 
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Improved Risk Assessment Profile Tool 
The purpose of the Risk Assessment Profile (RAP) is to guide decision-making by having 
CONNECTIONS calculate a risk score that is a valid predictor of the likelihood that a child will 
be abused or maltreated in the future.  Research and review of cases uncovered common 
errors in how workers throughout the State interpreted and applied the risk elements. This led to 
inaccurate risk scores which meant the risk rating may not be as reliable and useful in helping 
you to decide which cases to open for services. Therefore, making the descriptions in the RAP 
elements as close as possible to what the research has proved to be predictors of the likelihood 
of any type of abuse or maltreatment has been incorporated into a new RAP. This RAP will be 
implemented with Q3-08 (Build 18.10) in the INV and FSS stages. 

Elements in the RAP have been updated in order to increase the: 

• correctness in interpretation and application of risk elements; 

• accuracy of risk scores for investigations and service planning; and 

• precision of forecasted likelihood of recurrence of abuse or maltreatment.   

The following rules will apply to the implementation of the revised RAP to cases that existed 
before the implementation of Q3-08 (Build 18.10) 

INV or FSS-Initial FASP -   If the RAP, or the Initial FASP, was approved, rejected, pending 
approval, or in process (information was saved in the RAP module) prior to build 
implementation, you will see the pre-implemented version of the RAP elements on the Risk 
Assessment Profile window and output. 

FSS- Comprehensive and Reassessment FASP - If the FASP was in-process and information 
was saved in the RAP module when Q3-08 (Build 18.10) is implemented, you will see the post-
implemented version of the RAP elements on the Risk Assessment Profile window and RAP 
Component report and once approved, the Full FASP report.  If the FASP is pending approval 
at the point of implementation, the Full FASP report will contain the pre-implemented version of 
the RAP questions. 1  

 

                                                 
1 While the FASP is in PEND status, you will see the post-implemented version of the RAP on the window 
and component report. 
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Q3-08 (Build 18.10) Changes to Risk Assessment Profile Elements 
Below is the comprehensive list of RAP elements. For the purposes of this job aid, Q3-08 (Build 
18.10) wording changes are in bolded text, however, text in the actual CONNECTIONS window 
will not display as bolded. 

Questions 2-6 refer to the RAP Family Unit Stage Composition and require a Yes or No answer. 

Questions 7-15 refer to Primary and Secondary Caretakers and require a Yes or No answer for 
each individual identified as a Caretaker. 

 Risk Element Rationale for Change 

1.  Total prior reports for adults and 
children in RAP family unit. 

No Change. 

2.  Any child in the RAP family unit 
was in the care or custody of any 
substitute caregivers (informally or 
formally) at any time prior to the 
current report date. 

– Clarified to apply whenever a child has 
been in out-of-home care, informally or by 
court order, not only to previous foster care 
placements.  

– Substitute living arrangement does not 
need to have been due to child protective 
concerns; could have been informal family 
arrangement.  

– The research shows a link between 
parental inability or unwillingness to care for 
their children, the need for others to provide 
that care and the likelihood of some form of 
abuse or maltreatment in the future.  

3.  Child under one year old in RAP 
family unit at time of the current 
report, and/or new infant since 
report. 

– Need to always factor into the RAP a new 
baby born since the report was received. 

4.  Current or recent history of 
housing with serious health or safety 
hazards; extreme overcrowding; 
unstable housing; or no housing. 

– Need to consider recent history of housing 
stability and condition issues, even if 
problems have abated at time of completing 
the RAP. 

– Homelessness or an unstable housing 
situation is also included in this risk 
element. Temporary shelter that requires 
frequent relocation is not adequate, stable 
housing. 

5.  Financial resources are 
mismanaged or limited to the 
degree that one or more basic 
family needs are intermittently or 
chronically unmet. 

– Clarified to apply in more than extreme 
cases or only if multiple needs were not 
met.    

– If available financial resources are sufficient 
to meet the family’s basic needs, but are 
not sufficient due to mismanagement or 
inappropriate use of funds, factor applies.  
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– “Intermittently or chronically unmet” does 
not need to be continuous. Could reflect a 
pattern of shifting from financial crisis to 
relative stability to financial crisis. If that is 
the case, risk element applies. 

6.  Caretaker has, and utilizes, reliable 
and constructive support and 
assistance from extended family, 
friends, or neighbors. 

– Clarified to apply the risk element when 
there is helpful family, friends and 
neighbors but the caretaker does not take 
advantage of their offered help.  

7.  Caretaker has been a victim or 
perpetrator of abusive or 
threatening incidents with 
partners or other adults in 
family/neighborhood. 

– Clarified to expand the focus to 
relationships beyond the adults in the 
nuclear family.  

– Should include domestic violence between 
intimate partners. 

– Also refers to violent or threatening 
relationships with other non-partner adults.  

– Element broader than physical violence 
between current intimate partners. For 
example, threats or harassment included, 
even if no physical contact has occurred.  

8.  Caretaker’s alcohol use has had 
negative effects on child care, 
family relationships, jobs, or 
arrests, within the past two years. 

– If caretaker behavior suggests alcohol (#8) 
or drug #9) problems, this element should 
be checked even if a professional  
evaluation has not been completed  

– Check factor if use of these substances has 
had a negative effect on the person’s life 
within the past two years.    

– Applies if  regular or periodic use of one or 
more drugs has had adverse effects on any 
aspect of relationships or responsibilities  

– Select Yes for #8 if the caretaker is 
currently participating in an alcohol 
treatment program.  

– If the caretaker is participating in a non-
professional support group, such as 
Alcoholics Anonymous (AA), without any 
other evidence of continuing alcohol use 
within the last two years, do not consider 
this, by itself, as a current alcohol problem. 

9.  Caretaker’s drug use has had 
negative effects on child care, 
family relationships, jobs, or 
arrests, within the past two years. 

See # 8 above 
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10.  Caretaker's behavior suggests a 
mental health problem exists 
and/or caretaker has a diagnosed 
mental illness. 

– If caretaker behavior suggests mental 
health problems, this element should be 
checked even if a professional mental 
health evaluation has not been completed.  

– This risk element should be checked even if 
the person is appropriately attending to his 
or her mental health problem through 
treatment or prescribed medication.  

11.  Caretaker has very limited cognitive 
skills. 

No change 

12.  Caretaker has a debilitating physical 
illness or physical disability. 

No change 

13.  Caretaker demonstrates 
developmentally appropriate 
expectations of all children. 

– Focus on what parents do or do not do with 
all children in the family.  

14.  Caretaker attends to needs of all 
children and prioritizes the 
children’s needs above his/her 
own needs or desires. 

– Isolated or temporary instance of not 
meeting a child’s needs may not apply.   

– Does apply if instance was seriously 
dangerous lapse or caretaker evidences a 
lack of concern about potential for harm to 
the child.   

– Factor applies if caretaker knowingly does 
not protect a child from physical or sexual 
abuse by another person, or they have 
physically or sexually abused their child. 

15.  Caretaker understands the 
seriousness of current or 
potential harm to the children, 
and is willing to address any 
areas of concern. 

– Consider if children were harmed or if there 
is a potential for them to be harmed, does 
the caretaker see that, and, are they willing 
to do anything about it? Or do they 
minimize the harm to which the children 
have been exposed?  

– If the caretaker verbally agrees that there 
are behaviors or conditions that have 
harmed or could likely harm the child, but 
the caretaker does not follow through with 
appropriate actions, this Risk element 
applies  

 

Note that there have not been any changes made to the elevated risk elements, such as a 
previous termination of parental rights, that automatically increase the rating to” high.”  
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Enhanced Progress Notes 

Larger Font for Progress Notes Printouts 

With the implementation of Q3-08 (Build 18.10), you will be given a choice of font size for 
progress notes outputs. The system default is 8pt; however, you will be able to choose a larger 
font (12pt) by selecting “Larger (12pt)” from the Print Notes window. 

When “Standard (8pt)” is selected on the Print Notes window, the data fields and/or narrative in 
the print preview and output will have 8pt font size. When “Larger (12pt)” is selected, depending 
upon which radio button you select, the data fields and narrative in the print preview and output 
will have 12pt font size. 

In order to select “Larger (12 pt),” the Data Fields and Narrative radio button must be selected 
first. 

 

Step-by-Step: 
Printing Progress Notes in Larger Font Size 

 

1. From the Progress Notes tab, select the Progress Notes you want to print on the 
Progress Notes tab (of the FSS or CPRS window). 

2. Click on the Print Note(s) button on the lower right hand corner of the window.  
The Print Notes window displays. 
 

3. Click on the Data Fields and Narrative radio button in the Print Selected Progress 
Notes section. 

 

 

 

 

 

 

 

 

 

4. Click on the Larger (12pt) radio button in the Text Size section.  

5. Click on the OK button.  
Your print preview and printout will show the larger 12 pt font size. 
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Pre-Filled Focus Indicator 
 

Progress notes that record caseworker contacts with foster children are often not counted 
towards meeting the federal contact requirement because incorrect data values were selected. 
One of the most frequent issues is the failure to identify the child as the Focus of the contact. 

With the implementation of Q3-08 (Build 18.10), when an individual from the Family List is 
selected as a Participant, the individual will now also be system identified as the Focus. This 
applies to progress notes in both the INV and FSS stages.   

Points to remember: 

• When you select a person from the Family Participant checkbox, the corresponding 
Focus checkbox will be automatically selected. 

• When you deselect a person from the Family Participant checkbox, the corresponding 
Focus checkbox will be automatically deselected. 

• You are able to deselect the Focus checkbox without deselecting the Family 
Participant checkbox for the corresponding person. 

• You are also able to select the Focus checkbox, without selecting the Family 
Participant checkbox for the corresponding person. 

• Selection of the “All” pushbutton will automatically pre-fill both the Family Participant 
and the Focus checkboxes for all persons listed. 

What’s 
New 

Progress Notes Detail Window 
Family Participant/Focus 

 

 

Family 
Participant 

 

Focus 
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New To-Do Management Tool for Unit Approvers 

With the implementation of Q3-08 (18.10), it will no longer be necessary for supervisors and 
managers to request OCFS to perform a data fix to remove any outstanding Task To-Dos 
associated with a worker who has left their district or agency. When a worker leaves the job, 
his/her To-Dos need to be completed or reassigned. Currently, Unit Approvers have to go 
through every To-Do for the worker who left and complete every task before they can end date 
the worker. But after the implementation of Q3-08 (Build 18.10), Unit Approvers will be able to 
reassign these tasks to another worker for completion.  

Please note the Staff button or the Staff Search Criteria command (within the Options menu)) 
on the To-Do Detail window will be enabled for the Unit Approver (of the unit to which the 
departing worker was in-assigned), when accessed through the Unit Summary Path (Unit 
Summary>Search>To-Do>Detail). Using either of these features the Unit Approver can assign 
the Task To-Do to another worker. 

Another change is that the message concerning outstanding Task To-Dos is different. When a 
Unit Approver enters a date in the End Date field on the Staff Detail window and clicks on the 
Save button, the system will check for any outstanding Task To-Dos for that worker. If the 
worker has outstanding To-Dos after s/he is end dated, the following message will display upon 
clicking on the Save button.  

“Employee has outstanding system generated Task To-Dos which must be completed or 
transferred.” 

 

Step-by-Step: 
Re-Assigning Task To-Do’s for Unit Approvers 

 
1. Click Unit Summary button on the CONNECTIONS toolbar.  

The Unit Summary window displays. 

2. Click on the Search button.  
The staff assigned to the unit display. 
 

3. Click to select the worker for whom To-Dos must be reassigned.  

4. Click on the To Do… button.  
The Staff To-Do list for the worker displays. 

 
5. Click to select a To-Do which will be reassigned.  

The To-Do highlights. 
 

6. Click on the Detail… button.  
The To-Do Detail window displays. 

7. Click on the Staff… button or in the Options menu select Staff Search 
Criteria…choice.  
The Staff Search Criteria window displays. 

8. Enter search criteria for the staff person to whom you will reassign the To Do. 
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9. Click on the Search button.  
The Staff List window displays that match the criteria. 

10. Click to select the staff person to who you will reassign the To-Do.  
The person’s name highlights. 

11. Click on the OK button.  
The To-Do Detail window displays with the selected staff person’s name in the Assigned 
To field. 

12. Click on the Save button.  
The Staff To-Do List window displays. 

13. Click on the Close button.  
The Unit Summary window displays. 

14. Click on the Close button. 
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Changes in Language to FAD Fingerprint Requirement 
Letters and Denial/Revocation Letters 

The federal Adam Walsh Child Protection Act of 2006 eliminates the ability for states to "opt out" 
of the Title IV-E criminal history record check requirements for prospective foster and adoptive 
parents. As of October 1, 2008, it becomes New York State's standard to require that applicants 
to become foster and adoptive parents who were convicted of certain categories of felonies, or 
persons who have already been certified or approved to be foster or adoptive parents who are 
subsequently (after October 1, 2008) convicted of certain categories of felonies, must be 
disqualified from becoming foster or adoptive parents, or must have their certification or 
approval revoked. This disqualification/revocation is mandatory.  

The Fingerprint Requirement Letters (both English and Spanish versions) and the 
Denial/Revocation Letters (both English and Spanish versions) will be updated with Q3-08 
(Build 18.10) to reflect the Mandatory Disqualifier language in the law as of October 1, 2008. 

Until Q3-08 (Build 18.10) is released, use the notice/letter that will be sent with the 
Administrative Directive (ADM) that will be provided to local social service districts and voluntary 
agencies.   

Please also note that the values in the Fingerprint Results dropdown on the Household Member 
Detail tab in the Foster and Adoptive Home Record Summary have changed to reflect the new 
value of “Mandatory Disqualifier.”  The new “Mandatory Disqualifier” value will be ready for use 
on October 1, 2008 in advance of the implementation of Q3-08 (Build 18.10).   

What’s 
New 

Fingerprint Results Dropdown menu on the Household Member Detail Tab 

 

 

 

 

 

Values for 
Fingerprint 
Results 
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Support Tools 

Online Help 
 

CONNECTIONS Online Help provides descriptions for various windows, as well as step-by-step 
instructions for common tasks. You can access Online Help at any time, from any window in 
CONNECTIONS by clicking on the Help menu or pressing the F1 key on your keyboard. 

The Contents, Index and Search tabs in Online Help allow you to search for and navigate to 
the topic(s) on which you need help. 

 

Step-by-Step: 
Accessing Online Help 

1. Click on the Help menu on the CONNECTIONS Toolbar. 
The following list of commands displays: 

Contents A table of contents for the help facility with links to major sections. 
How Do I? Step-by-step instructions to help you complete tasks using 

CONNECTIONS. 
Window 
Descriptions 

Descriptions of windows in CONNECTIONS, along with information on 
various fields. 

DSS Policy Online OCFS policy handbooks (under revision). 
Help On This 
Window 

Window description help for the window you are on. 

Help for Help Instructions on how to use the help functionality. 
About 
CONNECTIONS 

Information about the current CONNECTIONS version and build. 

2. Click on a command from the Help menu. 
The window related to your selection displays. In some cases, you will need to make 
another selection in that window to obtain instructions. At the top of each window you will 
see additional buttons and menus. Use the Search button to search for specific 
information in the Help function and use the Back button to return to windows you have 
just visited in Help. The Glossary button opens a list of important CONNECTIONS 
terms and the Print button allows you to print Help information. 

3. When you are done reviewing information in Help, close each Help window by clicking 
on the Close button ( ) in the top right corner of the window. 
The system returns to the window you were using when you accessed Help. 
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OCFS CONNECTIONS Intranet Site 
A variety of training-related materials are available from the OCFS CONNECTIONS intranet site 
(http://ocfs.state.nyenet/connect/). The intranet site contains a wealth of information related to 
various aspects of CONNECTIONS, including training schedules, Alerts and Notices, Step-by-
Step Guides (including the CONNECTIONS Case Management Step-By-Step Guide), Job Aids 
and Frequently Asked Questions (FAQs). Release Notes—a complete list of the modifications, 
enhancements, fixes and impacts in the Build—is also available from the CONNECTIONS 
intranet site. 

 

Step-by-Step: 
Accessing the OCFS CONNECTIONS Intranet Site 

1. From your local desktop, double-click on the Internet Explorer icon. 

2. If the browser does not display the OCFS intranet site automatically, enter 
http://ocfs.state.nyenet into the browser’s address line and press the Enter key on your 
keyboard. 
The OCFS intranet home page displays. 

3. Click on the CONNECTIONS link. 
The CONNECTIONS home page displays. 

4. Click on a topic to access information. For access to various Step-by-Step Guides and 
Job Aids, click on the Step-by-Step/Job Aids/Tips link. For access to Quarterly 
Improvement Release Notes for Q3-08, click on the Implementation link. 

5. To close Internet Explorer, click on the File menu and select Close. 

Enterprise Help Desk 
The New York State Office for Technology (NYS OFT) Enterprise Help Desk staff is available to 
answer basic questions related to your equipment or to solve problems you are having with the 
CONNECTIONS application. If they cannot solve your problem, they will record your information 
and forward it to others who can. 

Your agency may have procedures in place for contacting the Enterprise Help Desk. Check with 
your supervisor before you call. 

The Enterprise Help Desk is staffed 24 hours a day, seven days a week. The telephone number 
is: 

1-800-NYS-1323 
(1-800-697-1323) 

When you call the Enterprise Help Desk with a problem, you will be given a ticket number to use 
for tracking your issue and its resolution. Keep a record of this number; you will need it for any 
follow-up conversations with the Enterprise Help Desk. 
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App Help Mailbox 
In addition to calling the Enterprise Help Desk with application 
issues, district staff can directly contact the NYS 
CONNECTIONS User Support/Triage staff for help with 
complex application issues. Questions, problems and concerns 
can now be emailed to:  

ocfs.sm.conn_app@ocfs.state.ny.us 
The ‘App Help’ mailbox is intended to provide an expanded 
level of support. It is meant for questions that have had an initial 
review by agency staff who are proficient in CONNECTIONS 
(e.g., Resource Users). For example, if you have an issue for 
which you have unsuccessfully sought advice from your supervisor or a Resource User, it would 
be appropriate to contact the App Help mailbox with the issue. However, your in-agency 
resources should always be your first contact when trying to resolve an issue. 

 
For more information on the 

App Help mailbox, refer to the 
Implementation page of the 

OCFS CONNECTIONS 
intranet site: 

http://ocfs.state.nyenet/connect/
imp/ 

 

http://ocfs.state.nyenet/connect/imp/
http://ocfs.state.nyenet/connect/imp/
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Appendix A: Safety Definitions  
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Safety 
A child is safe when there is no immediate or impending danger of serious harm to a 
child’s life or health as a result of acts of commission or omission (actions or inactions) 
by the child’s parents and/or caretakers.  

Safety Factor 

A Safety Factor is a behavior, condition, or circumstance that has the potential to place a child 
in immediate or impending danger of serious harm.  

Immediate Danger 

A child is in immediate danger when presently exposed to serious harm. In deciding whether the 
child(ren) is in immediate or impending danger, consider the following: 

• the seriousness of the behaviors/circumstances reflected in the safety factor; 
• the number of safety factors present; 
• the degree of the child(ren)’s vulnerability and need for protection; and 
• the age of the child(ren). 

 

Impending Danger 

A child is in impending danger when exposure to serious harm is emerging, about to happen, or 
is a reasonably foreseeable consequence of current circumstances.  In deciding whether the 
child(ren) is in immediate or impending danger, consider the following: 

• the seriousness of the behaviors/circumstances reflected in the safety factor; 
• the number of safety factors present; 
• the degree of the child(ren)’s vulnerability and need for protection; and 
• the age of the child(ren). 

 

Safety Decision 

The Safety Decision is a statement of the current safety status of the child(ren) and the actions 
that are needed to protect the child(ren) from immediate or impending danger of serious harm.  
A safety decision is dynamic, and is always based on the information you have available to you 
at the time of the decision. 

Safety Plan 

A safety plan is: 

• is a clearly identified set of actions, including controlling interventions when  necessary, 
that have been, or will be taken without delay, to protect the child(ren) from immediate 
or impending danger of serious harm;   

• addresses all of the behaviors, conditions, or circumstances that create the immediate 
or impending danger of serious harm to the child(ren); 

• specifies the tasks and responsibilities of all persons (Parent/Caretaker, 
household/family members, caseworker, or other service providers) who have a role in 
protecting the child(ren); 

• delineates the timeframes associated with each action or task in the plan that must be  
implemented;  
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• identifies how the necessary actions and tasks in the plan will be managed and by 
whom;   

• must be modified in response to changes in the family’s circumstances, as necessary, 
to continually protect the child(ren) throughout the life of the case; and 

• is necessary until the protective capacity of the Parent/Caretaker is sufficient to 
eliminate immediate or impending danger of serious harm to the child(ren) in the 
absence of any controlling interventions. 

 

A safety plan is not a set of educational, rehabilitative or supportive activities or 
services intended to reduce risk, address underlying conditions and contributing 
factors, or to bring about long-term and lasting change within a family. 

Controlling Interventions: 

Controlling interventions are activities or arrangements which protect a child from situations, 
behaviors or conditions which are associated with immediate or impending danger of serious 
harm, and without which the dangerous situations, behaviors or conditions would still be 
present, would emerge, or would in all likelihood immediately return. 
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CONNECTIONS Q3-08 (Build 18.10) (9/24/2008)                                                  30

Below is the comprehensive list of safety factors that display on the Safety Factors tab of the 
Safety Assessment window. Q3-08 (Build 18.10) wording changes are in bolded text, which is 

used only for the purposes of this job aid and not in the CONNECTIONS application itself. 

1. Based on your present assessment and review of prior history of abuse or 
maltreatment, the Parent(s)/Caretaker(s) is unable or unwilling to protect the 
child(ren). 

2. Parent(s)/Caretaker(s) currently uses alcohol to the extent that it negatively impacts 
his/her ability to supervise, protect and/or care for the child(ren). 

3. Parent(s)/Caretaker(s) currently uses illicit drugs or misuses prescription 
medication to the extent that it negatively impacts his/her ability to supervise, protect 
and/or  care for the child(ren).   

4. Child(ren) has experienced or is likely to experience physical or psychological harm as a 
result of domestic violence in the household. (No changes made here) 

5. Parent(s)/Caretaker(s)’s apparent or diagnosed medical or mental health status or 
developmental disability negatively impacts his/her ability to supervise, protect, and/or 
care for the child(ren). 

6. Parent(s)/Caretaker(s) has a recent history of violence and/or is currently violent and 
out of control. 

7. Parent(s)/Caretaker(s) is unable and/or unwilling to meet the child(ren)’s needs for food, 
clothing, shelter, medical or mental health care and/or control child’s behavior. 

8. Parent(s)/Caretaker(s) is unable and/or unwilling to provide adequate supervision of the 
child(ren). (No changes made here) 

9. Child(ren) has experienced serious and/or repeated physical harm or injury and/or 
 the Parent(s)/Caretaker(s) has made a plausible threat of serious harm or injury to the 
child(ren).  

10. Parent(s)/Caretaker(s) views, describes or acts toward the child(ren) in predominantly 
negative terms and/or has extremely unrealistic expectations of the child(ren). (No 
changes made here) 

11. Child(ren)’s current whereabouts cannot be ascertained and/or there is reason to believe 
the family is about to flee or refuses access to the child(ren). (No changes made here) 

12. Child(ren) has been or is suspected of being sexually abused or exploited and the 
Parent(s)/Caretaker(s) is unable or unwilling to provide adequate protection of the 
child(ren). 

13. The physical condition of the home is hazardous to the safety of the child(ren). 

14. Child(ren) expresses or exhibits fear of being in the home due to current behaviors 
of Parent(s)/Caretaker(s) or other persons living in, or frequenting the household. 

15. Child(ren) has a positive toxicology for drugs and/or alcohol. 

16. Child(ren) has significant vulnerability, is developmentally delayed, or medically 
fragile (e.g. on Apnea Monitor) and the Parent(s)/Caretaker(s) is unable and/or 
unwilling to provide adequate care and/or protection of the child(ren). 
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17. Weapon noted in CPS report or found in the home and Parent(s)/Caretaker(s) is 
unable and/or unwilling to protect the child(ren) from potential harm. 

18. Criminal activity in the home negatively impacts Parent(s)/Caretaker(s) ability to 
supervise, protect and/or care for the child(ren). 

19. No Safety Factors present at this time. 
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Q3-08 (Build 18.10) wording changes are in bolded text, which is used only for the purposes of 
this job aid and not in the CONNECTIONS application itself. 

Safety Decision Result 

1. No Safety Factors were identified at this 
time.  Based on currently available 
information, there is no child(ren) likely to 
be in immediate or impending danger of 
serious harm.  No Safety 
Plan/Controlling Interventions are 
necessary at this time. 

If #1 is selected, both the Prnt/Crtkr 
Actions/Safety Plan and Ctrl 
Interventions/Safety Plan tabs are disabled. 

2. Safety Factors exist, but do not rise to the 
level of immediate or impending danger 
of serious harm.  No Safety 
Plan/Controlling Interventions are 
necessary at this time.  However, 
identified Safety Factors have been/will 
be addressed with the 
Parent(s)/Caretaker(s) and reassessed. 

If #2 is selected, the Prnt/Crtkr 
Actions/Safety Plan tab is enabled; however, 
the system does not require you to record a 
narrative.  

The Ctrl Interventions/Safety Plan tab is 
disabled. 

3. One or more Safety Factors are present 
that place the child(ren) in immediate or 
impending danger of serious harm.  A 
Safety Plan is necessary and has been 
implemented/maintained through the 
actions of the Parent(s)/Caretaker(s) 
and/or either CPS or Child Welfare 
staff.  The child(ren) will remain in the 
care of the Parent(s)/Caretaker(s). 

If #3 is selected, both the Prnt/Crtkr 
Actions/Safety Plan and Ctrl 
Interventions/Safety Plan tabs are enabled 
and required. 

4. One or more Safety Factors are present 
that place the child(ren) in immediate or 
impending danger of serious harm.  
Removal to, or continued placement in, 
foster care or an alternative placement 
setting is necessary as a Controlling 
Intervention to protect the child(ren). 

If #4 is selected, the Placement window opens, 
which you are required to complete.  

Prnt/Crtkr Actions/Safety Plan tab is enabled 
and optional  
 

Ctrl Interventions/Safety Plan tabs is 
enabled and required. 

5. One or more Safety Factors are present 
that place or may place the child(ren) in 
immediate or impending danger of 
serious harm, but Parent(s)/Caretaker(s) 
has refused access to the child(ren) or 
fled, or the child(ren)’s whereabouts are 
unknown. 

If #5 is selected, the Ctrl Interventions/Safety 
Plan tab is enabled and required and the 
Prnt/Crtkr Actions/Safety Plan tab is 
disabled. 
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Appendix D: Controlling Interventions 
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Below is the comprehensive list of controlling interventions that display on the Controlling 
Interventions/Safety Plan tab of the Safety Assessment window. Q3-08 (Build 18.10) additions 
or wording changes are in bolded text, which is used only for the purposes of this job aid and 
not in the CONNECTIONS application itself. 

1. Intensive Home Based Family Preservation Services 

2. Emergency Shelter 

3. Domestic Violence Shelter - new 

4. Non-offending Prnt/Crtkr has been Moved to a Safe Environment with the Child(ren)  
5. Authorization of Emergency Food/Cash/Goods 

6. Judicial Intervention  

7. Order of Protection - new 
8. Law Enforcement Involvement 

9. Emergency Medical Services – separated out from mental health services in #10 and 11 

10. Crisis Mental Health Services - new 
11. Emergency In-patient Mental Health Services - new 

12. Immediate Supervision/Monitoring - reworded 

13. Emergency Alcohol Abuse Services 

14. Emergency Drug Abuse Services 

15. Correction or Removal of Hazardous/Unsafe Living Conditions 

16. Placement - Foster Care 

17. Placement - Alternate Caregiver 

18. Supervised Visitation - new 
19. Use of Family, Neighbors, or Other Individuals in the Community as Safety Resources 

(specify) – comment required 

20. Alleged Perpetrator has left the Household Voluntarily and Current Caretaker will 

Appropriately Protect the Victim(s) with CPS Monitoring 

21. Alleged Perpetrator has left the Household in Response to Legal Action 

22. Follow-up to Verify Child(ren)’s Whereabouts/Gain Access to the Child(ren) - new 

23. Other (specify) - comment required 
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Appendix E: Safety Plan Outputs 

 

 



INV Stage Safety Plan Sample



INV Stage Safety Plan Sample



FSS Stage Safety Plan Sample



FSS Stage Safety Plan Sample
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